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Preface 

 

 
What is MOODLE? 

Moodle (Modular Object-Oriented Dynamic Learning Environment) is a free, online 

Learning Management System enabling educators to create their own private website filled with 

dynamic courses that extend learning, anytime, anywhere. Moodle was originally developed by 

Martin Dougiamas, a computer scientist and educator, to help educators create online courses with 

a focus on interaction and collaborative construction of content, and it is in continual evolution. More 

than 30,000 educational organizations universally use Moodle to deliver online courses and to assist 

traditional face-to-face courses. Moodle is available for free on the Web (http://www.moodle.org), 

so anyone can download and install it. 

Moodle is available to students at any time on any internet-connected computer, laptop 

or device with a web browser both on and off the college campus. The real advantage of Moodle 

is that you can catch up on your work at any time. One of the key reasons for Moodle’s popularity 

is its potential to be extended with modules. 

 
 

Who is this book for? 

This book is for those who want to teach a course using Moodle. You can use Moodle to 

demonstrate a fully online course or to supplement a face-to-face course in an out-dated situation. 

You can use the tools and features available in Moodle to create an effective class. 

This book will teach you, how to include various activities / resources in Moodle that will 

be useful to you and your students to indicate how these activities/resources are used in teaching. 

This first edition includes most of the features in Moodle 3.5, such as the creating 

categories/courses, assigning new roles and permissions, creating online tests, Assignments, 

including Files, Folders, Video Embedding and much more. 

 
Prerequisites—What Do You Need Before You Start? 

To use this book, you will need the following: 

• Moodle installed and configured on a server. 

• A computer with Intranet or Internet access. 

• A web browser such as Internet Explorer, Mozilla Firefox, Safari, or Opera. 

 

About Us: 

Author: Dr. Sambath M., Associate Professor, Dept. of CSE 
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I Introduction 

 
Moodle(Modular Object-Oriented Dynamic Learning Environment) is a highly flexible open- 

source e-learning platform (also known as a Course Management System (CMS), or Learning 

Management System (LMS), or Virtual Learning Environment (VLE)). 

 
Moodle is to create a private website filled with dynamic courses that extend e-learning education 

anytime, anywhere with complete, customizable and secure learning management features. Moodle 

is designed to provide educators, administrators and learners with a single robust, secure and 

integrated system to create personalised learning environments. 

 
Moodle was originally developed by Martin Dougiamas to help educators create online courses with 

a focus on interaction and collaborative construction of content, and it is in continual evolution. The 

first version of Moodle was released on 20 August 2002. Nowadays the Moodle Project is led and 

coordinated by Moodle HQ, an Australian company of 50 developers which is financially supported 

by a network of eighty-four Moodle Partner service companies worldwide. Moodle's development 

has also been assisted by the work of open-source programmers. 

 
Moodle as a learning platform can enhance existing learning environments. As an E-learning tool, 

Moodle has a wide range of standard and innovative features such as calendar and Gradebook. 

Moodle is a leading virtual learning environment and can be used in many types of environments 

such as education, training and development and in business settings. 
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2 Login in to Moodle 

 

 
1. To log in to Moodle, visit https://lms.hindustanuniv.ac.in/ 

2. On the Web Login page, enter your Username (Faculty ID) and Password (Faculty ID in 

lowercase letters) and click the arrow or press enter/return on your keyboard. When you have 

successfully logged in, you will be returned to Moodle and will see your name and Moodle 

avatar in the user menu at the top-right of the page. 

Note: Change Password 
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3 Manage Courses and Categories 

 
You can manage the categories and courses using the Course and Category Management 

page. You can add categories or courses, move courses to different categories, and update any 

information. You can also use this page to backup courses, restore courses, and update enrolled 

users. 

 

 
 

 

 

3.1 Add Courses and Categories 
 

Steps: Administration > Site administration > Courses > Manage courses and categories > Create 

new Category 

 

Administrators can manually add courses and categories to the institution site in several locations. 

This section steps you through using the Manage courses and categories page with links to more 

detailed information that can be added to categories or courses. 
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1. From Site administration select Courses and Manage courses and categories. 

• You can add a course to an existing category by selecting the category name, or 

you can create a new category. 

2. To create a new category, complete the following steps: 

• Select Create new category to access the Add new category page. 

• Select a Parent category for your new category. 

• Type the Category name for your new category. 

• Type the Category ID number. 

 

Optional - The ID number of a course category is only used when matching the category 

against external systems and is not displayed anywhere on the site. If the category has an 

official code name it may be entered, otherwise the field can be left blank. 

• Type a Description for the category. 

• Select Create category. 

3. From the Course and category management page, select the name of the category. The list 

of courses appears in the Category area of the Course and category management page. 

4. To create a new course, complete these steps (while on the Course and category management 

page): 

• Select Create new course for the Edit Course Settings page. 

• Type the name of the course in the Course full name box. 

The full name of the course is displayed at the top of each page in the course and in the list 

of courses. 

• Type the abbreviated name in the Course short name box. 

The short name of the course is displayed in the navigation and is used in the subject line 

of course email messages. 

• Change the category for the course from the Course category list. 

• Determine if the course is Visible to all users. 

The default is to Show the course. You can choose to Hide the course from all users except 

teachers and administrators. 

• Select the Course start date. 

• Type the Course ID number. 

The ID number of a course is only used when matching the course against external systems 

and is not displayed anywhere on the site. If the course has an official code name it may be 

entered, otherwise the field can be left blank. 

• Type a Description for the course. 

• Select Save changes. 
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3.2 Move Courses to Different Categories 
 

Steps: Administration > Site administration > Courses > Manage courses and categories > 

Move selected courses to 
 

 

You can re-categorize a course to other categories or subcategories. 

 
1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the current category 

for the course. 

The list of courses appears in the Category area of the Course and category management 

page. 

3. Select the courses to move. 

4. Select then category where to Move selected courses to. 

5. Select Move. 

 

3.3 Edit Categories 
 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 

1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category you want 

to change. 

3. From the Actions menu available, select Edit. 

4. On the Edit category page, update any of the information available. 

5. Select Save changes when finished. 
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To move the location of a category in the list, select the Up or Down icons to rearrange the 

location of the category on the list. 

 

3.4 Edit Courses 
 

Steps: Administration > Site administration > Courses > Manage courses and categories 
 

1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category for the 

course. 

The list of courses appears in the Category area of the Course and category management 

page. 

3. Select the course to update. 

4. Select the Edit icon. 
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5. On the Edit course settings page, update any of the information available. 

6. Select Save changes. 

 
To move the location of a course in the list, select the Up or Down icons or drag the name of the 

course to the location on the list. 

 

3.5 Delete Categories 
 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 

You can delete a category including all the content available in the category, or you can move the 

content to another category first. 

1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category you want 

to delete. 

3. From the Actions menu available, select Delete. 

4. On the Delete category page, select what to do with the contents available in the category. 

Options include Move contents to another category and Delete all - cannot be undone. 

5. If moving content, select which category to Move into. 

6. Select Delete. 

 

 

3.6 Delete Courses 
 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 
1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category for the 

course. 
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The list of courses appears in the Category area of the Course and category management 

page. 

3. Select the courses to delete. 

4. Select the Delete icon. 

A message appears ensuring the deletion of the course. 

5. Select Continue to delete the course. 

 

 
3.7 Add Subcategories 

 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 

You   can   add   multiple   subcategories   under a   main   category. For   example, you can 

divide Humanities into Literature, Visual Arts, and Performing Arts. 

 
1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category where to 

add a subcategory. 

3. From the Actions menu available, select Create new subcategory. 

4. On the Add new category page, type the category details. 

5. Select Save changes when finished. 

6. After you have several subcategories added on the Manage courses and categoriespage, 

determine how to sort the subcategories: 

• To sort the list alphabetically, from the Actions menu, select Sort subcategories by 

name. 

• To sort the list by the identification code number of the subcategory, from 

the Actions menu, select Sort subcategories by id number. 
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3.8 Assign User Roles for Categories 
 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 

You can assign a specific user to manage or create courses within a category. For example, you may 

want the head of the English department to manage the English category. You can also assign 

specific users to create new courses within a category on your site. 

 

 
1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category you want 

to assign a user role. 

3. From the Actions menu available, select Assign roles. 

4. On the Assign roles in category page, select the Role link to assign a role: 

• Select Manager to assign to a category. 

A manager can access and change a course but usually does not participate in courses. 

• Select Course creator to assign a user to create courses in the category. 

5. On the Assign roles page, select the Potential user and select Add. 

 

 
3.9 Manage User Permissions for Categories 

 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 

You can determine which users can view or manage different actions a user role is allowed to 

complete in a category. The actions include which roles can update content, which roles can view 

different areas of the site, and which roles can manage grades. 
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1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category where 

you need to update permissions. 

3. From the Actions menu available, select Permissions. 

4. On the Permissions page, update any of the permissions available: 

• To remove a specific Role with permission, select the Delete icon. 

• To add a specific Role with permission, select the Add icon and select the specific 

user role. From the list, Select the role and select Add. 

• To prohibit a specific role from permission, from the Prohibited area, select 

the Add icon. Select the specific user role and select Add to prohibit that user role. 

 

3.10 Manage Filters for Categories 
 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 
Filters can be used to add links, insert multimedia players, and convert Mathematical expressions 

or emoticons into images and more. Determine whether or not to enable filters for a specific 

category. 

1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category where 

you want to manage filters. 

3. From the Actions menu available, select Filters. 

4. On the Filters page, set the filters you want for the category to On in the Activesetting. 

5. Select Save changes when finished. 
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3.11 Hide Categories or Courses 
 

Steps: Administration > Site administration > Courses > Manage courses and categories 

 

1. From Site administration select Courses and Manage courses and categories. 

2. From the Course and category management page, select the name of the category and/or 

course you want to hide. 

3. Select the View/Hide icon to change the status of the category or course. 
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4 Enrolling Users into Course 

 

Once you have created your Moodle course the next step is to enroll your learners into that course! 

The following instructions show how to enroll students in Moodle using manual Moodle 

enrolments. 

 

4.1 Method 1 

1. Dashboard > My Courses > Course 

 

Administration > Course Administration > Users > Enrolled Users 
 

 
 

2. Click the 'Enrol users' button at the top right or bottom left of the page 
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3. Use the 'Assign roles' dropdown if you wish to change the role. (Note that if your course has 

cohort enrolment, you will see 2 radio buttons (as in the screenshot) To enrol users individually, 

click the Browse users button. It should be selected by default.) 

4. Click to expand the enrolment options and set them as appropriate. These include the 

enrolment duration 

5. Browse or search for the user (Note that when searching for users, exact matches are listed 

first) 

6. Click the Enrol button opposite the user. The user will indent in the list and the enrol 

button will disappear, indicating that the user is enrolled. 

7. When you have finished, click the 'Finish enrolling users' button (or simply close the enrol 

users box) 

 

The user will then appear in the list of enrolled users. 

Note: The enrolment option 'Recover user's old grades if possible' is not ticked by default and is 

easy to miss. An admin can make it so that the checkbox is ticked for all courses on the site by 

enabling the setting 'Recover grades default' in the Site administration. 

 

 

 

4.2 Method 2 

 
1. Go to 'Enrolment methods' from the gear menu in the nav drawer Participants link (or 

in Course administration > Users in the Administration block if you are using a theme other than 

Boost) 

2. Click the 'Enrol users' icon in the edit column opposite manual enrolment 

3. Select users from the not enrolled users list, using Ctrl + click to select multiple users 

4. Click the add button to add the users to the enrolled users list. 
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Note: When searching for users, by default the user's email address is displayed in addition to 

their name. If preferred, an admin can set other user identity fields such as ID number to be displayed 

in 'Show user identity' in User policies in the Site administration. 

 

4.3 Method 3 

 
• To add more than one user at once quickly 

• Select Cohort 
 

 
 

 
 

4.4 Editing Individual Enrolment Start and End Dates 

 

1. Go to 'Enrolled users' from the gear menu in the nav drawer Participants link (or in Course 

administration > Users in the Administration block if you are using a theme other than 

Boost) 

2. Click the edit icon in the enrolment methods column for a particular user. 

3. Edit dates as required, then click the 'Save changes' button. 
 

 

https://docs.moodle.org/35/en/User_policies
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5 Adding Resources to a Moodle Course 

 
A Resource is an item that an instructor can use to support learning, such as a file or web link. Each 

resource appears as a link preceeded by an icon that represents the resource type (File, Folder, Page, 

URL, etc.). Most resources allow settings such as conditions for viewing, or display properties. They 

can be moved, hidden, and edited by a Teacher or Course Designer, but only viewed/downloaded 

by students. To allow a TA to add/edit resources in your course, add the Course Designer role for 

that individual. 

 
5.1 Types of Resources 

 
 

 
5.2 Add Resource using the Activity Chooser 

 
1. On your main course page, click Turn editing on (top right). Editing icons and links will 

appear. 

2. Locate the Section where you want the resource to appear, and click the Section title to open 

if it is collapsed. Click + Add an activity or resource. The Activity Chooser will open. 

3. Scroll down to the Resources heading. Click a Resource one time to see a description of the 

resource and support links in the right side of the window (double-clicking will add the 

resource to your Moodle page). 

4. Select the type of resource you want to add, then double-click or click Add. The Add 

Resource page will open. 

5. Depending on the type of Resource you've chosen, you will have different settings options. 

Click particular headings to view those settings, or Expand all (top right) to view all 

settings. 

6. Complete all required fields, then click Save and return to course or Save and display. 
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Once you have added a resource, you can: 

• Move the resource link up or down the course page by dragging it by its 

Move icon. You can even drag items between Sections. (If you use the Collapsed topics 

format, the target section must be toggled open.) 

• Configure its settings by clicking Edit (at right of resource), then selecting Edit 

settings from the Edit drop-down menu. 

• Hide a resource that you are not ready to release to students by clicking 

its Hide icon from the Edit drop-down menu. 

 

 

 

 
 

5.2.1 Add a Folder of Files to a Moodle Course 

Moodle allows you to post multiple files at once in a Folder. Folders can contain files such as PDFs, 

Word documents, or image files, but cannot contain Moodle Activities (such as Quizzes, 

Assignments, and Forums) or Resources (such as URLs or Pages). 

 
You can upload individual files or a ZIP file containing several files on your computer to a Folder. 

You can update the folder to add additional files, rename files, or move them into sub-folders. 

 
Note: You must first use the Activity Chooser to add a folder, as detailed below, then you can drag-

and-drop files into the upload box on the Adding a new folder page. You cannot use drag- and-drop 

a "folder" from your computer onto your Moodle course page, but you can drag-and- drop a .zip file 

and opt to unzip and create folder. 
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1. On your course page, click Turn editing on. 

2. Locate the Section where you want the resource to appear, and click the Section title to open 

if it is collapsed. Then click + Add an activity or resource. The Activity chooser will 

open. 

3. In the Activity chooser, scroll down to the Resources heading and select Folder, then click 

Add. The Adding a new folder page will open. 

4. In the Name field, provide a title for your folder (required). The name you enter will display 

as the link to the folder on your course page. 

5. In the Description field, add a brief description of the folder contents (optional). To display 

the description on the course page, check Display description on course page. 

6. Add files under the Content heading. The easiest way to add files is using drag-and-drop: 

• Arrange your computer's windows so that you can view both the Files area in Moodle 

and the files on your computer. 

 

• Drag files from your computer onto the large blue arrow in the Files area in Moodle. 

Note: To upload multiple files at once, hold down the CTRL key on your keyboard 

(Windows), or the COMMAND key (MAC) as you click each of the files you wish 

to upload. Then drag the files into the Files area in Moodle. 

7. Alternatively, you can use the File picker to browse for files on your computer. 

 
Note: The best way to upload multiple files with the File picker is to first make them into a .zip 

file, then unzip the file in Moodle. For directions on zipping files, see Create a   Zip File 

(below). 

• Under the Content heading, click Add... ( ) at top left of Files area. The File picker 

pop-up window will open. 

• Click Upload a file (left) and then click Choose file to search for and select the file 

on your computer. 

• Click Upload this file. The File picker window will close and the file will be listed 

in the Files area. 

• If you have uploaded a .zip file to your folder, the next step is to unzip it. In the 

Files area, double-click the zip file icon. A pop-up window for the file will open. 

Click Unzip (at top). The original files will appear along with the zip file in the Files 

area. 

 

5.2.1.1 Organize the Files within a Folder 

 
Files in folders are listed in alphanumeric order. To make the files appear in a particular order for 

your students, you will need to rename the files. 

https://www.umass.edu/it/support/moodle/add-a-folder-files-a-moodle-course#Create%20a%20Zip%20File
https://www.umass.edu/it/support/moodle/add-a-folder-files-a-moodle-course#Create%20a%20Zip%20File
https://www.umass.edu/it/support/moodle/add-a-folder-files-a-moodle-course#Create%20a%20Zip%20File
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• One option is to add numbers in front of the file names, for example: 

01-handout.pdf 

02- reading.pdf 

03- spreadsheet.xlsx 

04-instructions.docx 

• To rename files already in a Moodle Folder: 

 
1. On your course page, click Turn editing on. 

2. Locate the folder you want to configure and click its Edit link, and from the drop-down 

menu, click Edit settings. The Updating Folder window will open. 

3. Under Content, in the Files area, open any sub-folders as needed. To rename a file, click 

the File icon. A pop-up window will open. 

4. In the Name field, edit the name, thenclick Update. The pop-up will close and the Files 

area will show the new file name. 

Note: DO NOT remove or change the file extension (e.g., .pdf, or .docx). A proper file 

extension is required for the file to download and open for your students. 

5. Rename any other files and click Save and return to course. 

 
5.2.1.2 Create a Zip File 

 
To upload multiple files at once using the Moodle File picker, compress the files on your computer 

into a zip file. A zip file is a file type where multiple files or folders are compressed into a single, 

smaller file with a ".zip" file extension. Uploading multiple files to Moodle as a ZIP file can save 

you time and requires less clicking. 

 

Windows Users 

 
In your computer's file browser, hold down the Control key as you click to select the folders or files 

you wish to compress. Right click any of the selected files. In the drop-down menu that opens, 

scroll to the Send To option, and select Compressed (zipped) folder. A new ZIP file will appear 

in the same directory (folder) as the files you selected. You can rename the ZIP file for easier 

identification before uploading it to Moodle. 

 

Mac Users 

 

In your computer’s finder, right-click(control+click) on the folder or files and select Compress. A 

new zip file will appear on your computer in the same directory (folder) as the files you selected. 

You can rename the zip file for easier identification before uploading it to Moodle. 



19 
HITS-LMS 

Department of Computer Science and Engineering 

 

 

 

 

5.2.2 Add a File to a Moodle Course 

 
A File can be a text document, a spreadsheet, an audio file, video file, etc. 

 
5.2.2.1 Add a File using the ‘Add an activity or resource’ Link 

 

One of the ways to share a file with your students on Moodle is to add it to your course page as 

a Resource. File types you can add to Moodle include PDF, Word and other text documents, 

PowerPoint presentations, spreadsheets, zip files, and media such as image, video and audio files. 

 
Note: IT recommends that you use PDF when adding course materials such as readings or handouts. 

 
1. On your main course page, click Turn editing on (top right). 

2. Locate the Topic or Weekly Section where you will add the file. If you are using 

the Collapsed Topics format, open the section. 

3. At the bottom right of the section, click + Add an activity or resource. The Activity 

chooser will open. 

4. In the Activity chooser, scroll down to the Resources heading and select File. Then 

click Add. The Adding a new filepage will open. 

5. On the Adding a new File page, enter a title for your file in the Name field (required). 

The name you enter will display as a link to the file on your main course page. 

6. Under the Content heading, in the Select files area, click the Add ... ( ) icon or 

the Blue Arrow. The File picker will open. 

7. To search for a file on your computer, select Upload a file (at left), then click Browse or 

Choose File(depending on your browser). 

 

https://www.umass.edu/it/support/moodle/add-a-file-a-moodle-course#Add%20a%20File%20using%20the%20%22Add%20an%20activity%20or%20resource%22%20Link
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Double-click to select the file to upload. You will be returned to the File picker window. 

(Optionally, you can copy a file from your Google Drive. In the File picker window, leave the 

Save as field blank and click Upload this file. You will be returned to the Adding a new file 

page. 

8. Scroll down to the bottom of the page and click Save and return to course. You will 

be returned to your main course page. 

9. Click the file link to make certain the file opens properly. 

10. You can make adjustments by returning to your course page. On your main course page, 

click Turn editing on. Locate the link to the file: 

• To adjust the settings, click Edit (at right), and from the Edit drop-down menu 

choose Edit settings. 

• To rename the link, click the Edit title icon ( ) (immediately to the right of 

the link), enter a new title, then press Enter/Return on your keyboard. 

• To move the link from the bottom of the section, drag the Move resource icon ( 

 ) for the link (at left). 

 
 

 

 
5.2.2.2 Add Files using Drag and Drop 

 
The fastest way to add files to Moodle is using "drag and drop," which lets you drag files from 

your computer directly into a Section 

 

5.2.3 Using Label 
 

A label is a versatile module that can serve a spacer between resources on a course page. It can 

provide a space for embedding banners, sound or video files or displaying code from Web 2.0 

widgets. 

 
Steps : Main page > Managing a Moodle course > Resources > Label > Using Label 

https://docs.moodle.org/35/en/Main_page
https://docs.moodle.org/35/en/Managing_a_Moodle_course
https://docs.moodle.org/35/en/Resources
https://docs.moodle.org/35/en/Label


21 
HITS-LMS 

Department of Computer Science and Engineering 

 

 

 

 

 

5.2.3.1 Adding Images to a Label 

 
I. Drag and drop images 

• Media drag and drop must be enabled in 

Administration > Site administration > Plugins > Activity modules > Label 

 
• With the editing turned on, drag your image into the section you want it to appear. 

• In the box that follows, choose "add image" 

• It will appear embedded in a label. 
 

 
 

 

Drag an image onto your course 

page 

 

 

 

 
Choose "add image.." 

 

 

 

 

 
And here it is! 

 

 

 

II. Conventional method 

 
• Click the image icon in the text editor 

 

 
 

• Click ‘Browse repositories’ 

• Choose and upload your image using the filepicker. 

• Click ‘Save and return to course’ 

https://docs.moodle.org/35/en/HTML_editor
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5.2.3.2 Adding Text to a Label 

I. Conventional Method: Drag and drop text 

 

As the label uses the Text editor it is straightforward to enter text and other required symbols and 

equations. It is however possible also to drag and drop text directly into a label. 

 

Drag and drop upload of text/links must be enabled in 

 

Administration > Site administration > Development > Experimental  > Experimental 

settings 

• Select the text you wish to use, for example in a Word document. 

• With the editing turned on, drag the text over to the section you want it to appear. 

• From the box that appears, choose "add a label" and then "upload". 
 

 
 
 

Text selected from a Word document is 

dragged over 

 

 

 

Choose "add a label" (or page if you 

prefer) 

And here it is! 

 

 

 
 

5.2.3.3 Adding a Link to a Label 

 
I Conventional method: Drag and drop links 

 
As the label uses the Text editor it is straightforward to click the "link" icon and enter your linked 

URL. It is however possible also to drag and drop links directly into a label. 

 
Drag and drop upload of text/links must be enabled in 

• Administration > Site administration > Development > Experimental > Experimental 

settings 

• Open up a new window with the URL you wish to link to. Select the link in the browser 

bar. 

https://docs.moodle.org/35/en/Text_editor
https://docs.moodle.org/35/en/Text_editor
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• With the editing turned on, drag the URL over to the section you want it to appear. 

• From the box that appears, name the link and then click ‘upload’. 
 

 
 
 

Select your URL  

 

 

 
Name the link 

 

 
Here it is! 

 

 

 

 

 

 

5.2.3.4 Adding Sound or Video to a Label 

 
If multimedia filters are enabled, a label is a neat way of displaying sound or video in an inline 

player on the course page. 

• Follow the instructions for adding a label 

• Click the media icon in the text editor 
 

 

• Click "Find or upload an sound,video or applet" 

• Choose and upload your sound or video file using the filepicker 

Note: You can search youtube for a video to embed if your admin has enabled the youtube 

repository. 

• Leave Common module settings at "show" if you wish the label to be visible. 

• Click ‘Save and return to course’. 

https://docs.moodle.org/35/en/Label_module_settings
https://docs.moodle.org/35/en/HTML_editor


24 
HITS-LMS 

Department of Computer Science and Engineering 

 

 

 

 

 
 

 
 

 

5.2.3.5 Adding Code to a Label 

 
An example of this is the ability to embed a Google map into a label. 

• Follow the instructions for adding a label 

• Expand the toolbar and click the HTML icon in the text editor 
 

 
 

 
• This brings up the screen in code (HTML) view. 

• Paste the code you grabbed from Google maps into this screen 

• Scroll down and click ‘Update’. 

https://docs.moodle.org/35/en/Label_module_settings
https://docs.moodle.org/35/en/HTML_editor
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• Leave Common module settings at "show" if you wish the label to be visible. 

• Click "Save and return to course" 

 

 

 
 

Note: The success in adding code to a label depends both on the type of code and the permissions 

of the user. 

 

5.2.4 Link to a Web Page from a Moodle Course 

 
Students and instructors can create hypertext links anywhere they see an HTML Editor in Moodle. 

Instructors can also add a URL resource to a Moodle course page. This page explains how to create 

both kinds of links. 

 
A note about tracking use of resources: Instructors can track whether URL resources have been 

clicked by students ( Use Reports to Track Student Activity in Moodle). However, hypertext 

links added with the HTML Editor cannot be tracked, and will not show as Resources in 

the Activities block. 

https://www.umass.edu/it/support/moodle/use-reports-track-student-activity-moodle
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5.2.4.1 Create a Hyperlink in Text 

 
Students and instructors can create a link within text (hyperlink) anywhere the HTML Editor appears 

in Moodle. For example, students can create links in forum posts, and instructors can add links to 

Labels, Pages, Activity descriptions, etc. 

 
Many instructors use this method to link to Resources or Activities already in a course. For example, 

if you were asking students to submit a written response to a reading, you could post the reading as 

a File resource on the course page, then, in the description for the Assignment activity, also provide 

a hyperlink to that file. 

 
To create a hyperlink using the HTML Editor Toolbar: 

 

1. On your course page, click Turn editing on (top right). Editing icons and links will appear. 

2. To create a new Label, Activity, Page, Forum post, etc., at the bottom right of a Section, 

click + Add an activity or resource. The Activity chooser will open. Or click the Edit Settings 

for an item already in your course. 

3. Drag the cursor to select the text (or image) you would like to make into a link. 

4. On the Settings page for the item, in the text entry box, click the Link icon (     ). 

5. The Create Link pop-up window will open. In the Enter the URL field, enter the Web 

Address for the link. 

 
Note: To create a link to a Resource or Activity already in your Moodle course, on the course page, 

right-click the link to the item and choose Copy the link address. (Options in the right-click context 

menu vary depending on the browser in use.) 

 
6. (optional) To have the link open in a new browser window or tab, check Open in new 

window. 

We recommend using this option with caution, and only when linking outside your Moodle course. 

Spawning new browser tabs or windows impairs accessibility and is not handled equally well by 

mobile devices. 

7. Click Create Link. The Create Link window will be closed. 

8. The selected text (or image) will now be hyperlinked and text will appear in a new colour. 

Click Save and return to course (or Post to forum for forum posts), then open the Resource or 

Activity and click the new link to ensure it opens correctly. 
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5.2.4.2 Add a URL Resource to a Course Page 

 
Instructors can add a URL resource to a Topic or Weekly Section. 

 
1. On your course page, click Turn editing on (top right). Editing icons and links will 

appear. 

2. Locate the Section where you will add the link. (If you are using the Collapsed 

topics format, open the Section.) 

3. At the bottom of the section, click + Add an activity or resource. The Activity 

chooser will open. 

4. In the Activity chooser, scroll down to the Resources heading and select URL. 

5. Click Add. The Adding a new URL page will open. 

6. In the Adding a new URL page, fill in the required fields. 

▪ The Name field controls how the text of the link will appear on your course page. 

▪ The Description field will only appear to students if you check Display description on 

course page (below text entry box). 

▪ The External URL field is where you enter the URL of the website you wish to link to. 

 
Click the Appearance heading to view and adjust the settings. 

 
Note: For Display, the options to open in a New window or Use pop-up should be used with caution. 

Spawning new browser tabs or windows impairs accessibility and is not handled equally well by 

mobile devices 

 
When you have finished choosing settings, scroll to the bottom of the page and click Save and 

return to course. 

 

5.2.5 Create and Manage a Quiz in Moodle 

 
This contains instructions to help you create quizzes in Moodle by various methods, and to perform 

some basic tasks in relation to quizzes. 

 

Steps 

• Create a quiz shell 

• Add questions to a quiz 

• Add and edit question bank categories 

• Reactivate a quiz 

• Grant an extension for a quiz 

• View quiz reports 

https://teaching.unsw.edu.au/moodle-quiz
https://teaching.unsw.edu.au/moodle-quiz
https://teaching.unsw.edu.au/moodle-quiz#addqs
https://teaching.unsw.edu.au/moodle-quiz#editqbankcats
https://teaching.unsw.edu.au/moodle-quiz#reactivate
https://teaching.unsw.edu.au/moodle-quiz#indiv_special_access
https://teaching.unsw.edu.au/moodle-quiz#view_quiz_rpts
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If you are likely to want to use the questions in more than one quiz, you can build your quiz in two 

different ways: 

 

• Create the quiz / Create the questions in a question bank / Add questions to the quiz - or 

• Build a question bank / Create the quiz / Add questions to the quiz from the bank. 

 
5.2.5.1 Create a quiz 

 
To create a quiz, first create the quiz shell, then add questions to the shell, either creating them as 

you go or using existing questions in the course question bank. 
 

1. On the Moodle course home page, in the relevant section, click Add an activity, 

select Quiz from the list and click Add. 

2. On the Adding a new Quiz page, click Expand all at the upper right of the page. 

3. In the General section, enter a Name, and an introductory Description if necessary. 

 

 

4. In the Timing section: 

• Enable and select dates to Open the quiz and Close the quiz. 

• Enable and set a Time limit, if using. 

• Select the appropriate option for When time expires. 

• If you are allowing a grace period, Enable and nominate a Submission grace period. 
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5. In the Grade section: 

• Select the Grade category within the Gradebook where you want this assignment 

to belong. 

• Set the number of Attempts allowed, the Grade to pass and, if multiple attempts 

are allowed, which Grading method Moodle should use. 

 

 
 

6. In the Layout section: 

• Select where you want New page breaks to fall. 

• Click Show more and select, at Navigation method, whether you want Moodle to 

force students to answer questions sequentially. 

 

 

 

7. In the Question behaviour section: 

 
• Select whether to Show question names in Quizzes. 

• At Shuffle within questions, select whether you want multiple choice or matched 

question options randomised. 

• Select How questions behave. Deferred feedback (students must submit entire quiz 

before they see any grade or feedback) and Interactive with multiple tries (students submit 

each questions and get immediate feedback as they progress through the quiz) are the most 

common choices. 

• If you allowed multiple attempts, click Show more and select whether Each attempt 

builds on the last, if you want each new quiz attempt to contain the results of the previous 

attempt. This allows students several attempts to complete a quiz. 
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• Depending on your selection for How questions behave, you may choose whether 

to Allow redo within an attempt. 

 

 

8. Under Review options, select what you want the student to be able to see when they view 

their attempt or report at various stages. 

 
 

 
 

9. In the Appearance section, make choices about how you want the quiz to display: 

 
• Do you want to Show the user's picture during the attempt, and on the review 

screen, to make it easier to check that they are logged in as themselves in an invigilated 

exam? 

• How many Decimal places in grades do you want to display to the students for this 

quiz? 

• How many Decimal places in grades do you want to display to the students for 

individual questions in this quiz? 

• Click Show more and select whether you want the normal blocks to display during 

the student's quiz attempt. 
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10. Under Extra restrictions on attempts: 

 
• Do you want to Require password for students to access this quiz? 

• The Require network address setting is for proctored quizzes, to ensure that only 

students in a certain room can gain access to the quiz. Obtain the IP addresses for all rooms 

in which the quiz will be taken, and enter them in this field, separated by commas. 

• Enable and select whether you want to set up the 2 levels of Enforced delay. 

• Click Show more and select whether you want to set up Browser security and 

restrict students' view and activity further (read the relevant help text  ). 

• We recommend selecting No for the option to Allow quiz to be attempted offline 

using the mobile app. 

 

 

 

11. Overall feedback: Enter the Feedback text the students will automatically see, depending 

on which range of scores they fall within, as defined by the grades or percentages in 

the Grade boundary fields. 
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12. Complete any other necessary page sections, then click Save and display to access the 

page for adding questions to the quiz. 

13. For assistance adding questions to the quiz, see the instructions below 

 
5.2.5.2 Add Questions to a Quiz 

 
You can add questions to a quiz in 3 ways: 

 
I. Create them one at a time within the quiz 

II. Retrieve them from a question bank 

III. Import them from a file on your network or computer, or from one of your uploaded course 

files 

 

I. To create questions one at a time within a quiz 

 
1. On the course home page, with editing turned on, click the link for the quiz. 

 
 

 

2. On the quiz's home page select Edit quiz. 
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3. On the Editing quiz page, click Add and then select a new question. 
 
 

 
4. In the Choose a question type to add window, select the question type and click Add. 

 

 

5. On the Adding a [question type] question page, select a question Category, enter a 

Question name, some Question text and the Default mark, and then complete the 

remainder of the fields as required, clicking Help   for assistance if necessary. 
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Multiple choice question with multiple answers allowed: 

 
When you set up the answers for a question of this type, not only must the questions' combined 

Grade amounts add up to 100%, but you must also assign a negative Grade for the incorrect 

answers. If you don't, a student who selects incorrect answers as well as all the correct answers will 

be marked as if they answered the question correctly. 

 

6. If the question is complex and you want to check how it will display to the student, scroll 

to the bottom of the page and click Save changes and continue editing. Then: 

 

• Click Preview, and the question will display in the Preview question window. 

• If necessary, adjust the Attempt options and click Start again with these 

options to see how the revised question behaves. 

• If necessary, change Display options and click Update display options to check 

the display. 

• Close the window when you are happy with the way the question behaves. 
 

 
 

 

7. Click Save changes. The question displays on the Editing quiz page. Click the arrows 

to change its position within the quiz. 

 

 

 

 

II. To retrieve questions from a question bank 

1. On the Editing quiz page, click Add and then select from question bank. 
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2. Make your choice from the Select a category list. 

3. Select the check box(es) of the question(s) to be added to the text. 

4. Click the + icon next to the check box to add a single question, or click Add selected 

questions to the quizto add multiple questions to the quiz. The questions are added to the 

quiz. 

 
 

 
 

5. You can also add random questions from the chosen category to the quiz. 

 
III To import questions 

 
1. On the course home page, in the Settings block, select Course administration > Question 

bank > Import. 

 

 
2. On the Import questions from file page: 

 
• Select the File format. 
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• Complete the General fields as desired. 

• Choose a file to import. 

• Click Import. 

 

 

 
Aiken Format 
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Add a question to a question bank 

 
Every Moodle course comes complete with a question bank, where all questions created for the 

course are stored. To add questions to the bank: 

1. On the course home page, in the Settings block, select Course administration > Question 

bank > Questions. 

 
 

 
2. On the Question bank page, from the drop-down list, Select a category you want to add a 

question to. You can also select whether and how questions already created for that category 

display. 

3. Click Create a new question. 

 

 
4. In the Choose a question type window, select the question type and click Add. 
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5. On the Adding a [question type] question page, complete the question, answer and 

feedback fields as required, clicking the Help button  for assistance if necessary. 

 

6. If the question is complex and you want to check how it will display to the student, scroll 

to the bottom of the page and click Save changes and continue editing. Then: 

• Click Preview, and the question will display in the Preview question window. 

• If necessary, adjust the Attempt options and click Start again with these 

options to see how the revised question behaves. 

• If necessary, change Display options and click Update display options to check 

the display. 

• Close the window when you are happy with the way the question behaves. 
 
 

 

7. Click Save changes. The new question displays, highlighted, on the category page. 
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5.2.5.3 Add and Edit Question Bank Categories 

 
To start with, each course's question bank contains a single, 'Default' category. Create more, to make 

it easier to find questions, and to enable you to use random questions and matching questions more 

easily. 

 
Within the course question bank, you can create hierarchies of parent categories and subcategories. 

1. On the course home page, in the Settings block, select Course administration > 

Question bank > Categories. 

 

 

2. On the Edit categories page: 

• Select an appropriate Parent category from the drop-down list. Select Top to 

make this new category a top-level category. 

• Enter a Name for your new category. 

• Enter any Category info that will be useful for users compiling quizzes. 

• Click Add category. The new category displays in the list at the top of the page. 
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3. To edit the new category, click the Edit this category icon next to the category's name. 
 
 

 

4. On the Editing a category page, change the Parent category, Name and Category as 

desired, and click Save changes. 

 

 

5.2.5.4 Reactivate a Quiz 

 
To reactivate a quiz that has passed its close date: 

1. Click Turn editing on . 

2. Click Edit next to the quiz, and select Edit settings from the dropdown. 
 
 

 

3. On the Update quiz page, click open the Timing section and change the date in the Close 

the quiz fields to the new, extended close date. 
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4. Save your changes. 

 
5.2.5.5 Grant an Extension for a Quiz 

 
Note: Be careful when using quiz overrides. If is not recommended to use a combination of group 

and user overrides. If you must do so, note that user overrides take precedence over group overrides. 

To extend an individual's submission times or grant them special access to a quiz: 

 

1. On the course home page, click Turn editing on . 

2. Click the Update icon for the relevant quiz. 
 

 
 

 

3. On the Editing quiz page, in the Settings block, under Quiz administration, click User 

overrides. 
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4. On the resulting page, click Add user override. 
 
 

 
5. On the Edit override page, Search for the individual student, then make the appropriate 

changes. You can: 

o require this student to use a password to enter the quiz 

o specify different Open or Close dates or times (in the event of extenuating 

circumstances or special needs) 

o allow this student a different number of quiz attempts. 

6. Click Save. The overrides overview page displays, showing all current overrides and their 

details. Add another user override or return to the Editing quiz page. 

 



43 
HITS-LMS 

Department of Computer Science and Engineering 

 

 

 

 

5.2.5.6 View Quiz Reports 

 
To access reports relating to a quiz: 

 
1. On the course home page, click the quiz's link. 

2. In the Settings block, click Quiz administration > Results. 

3. Select from the list of the 4 types of reports available: Grades, Responses, Statistics or Manual 

Grading. 

 

 

 
 

Grades 

 

The Grades report tells you about student quiz attempts, displaying the overall grade, and a summary 

of each correct/incorrect answer. It also reports on the State (student progress through a quiz), the 

time the quiz was started/completed and the total time the student took to complete it. You can re-

grade quiz attempts by selecting Re-grade selected attempts. A bar graph summarises the grade 

range and frequency. 

 
Responses 

 
The Responses report is visually similar to the Grades report, but it shows the responses students 

gave to quiz questions, not the marks they earned. You can view the question text/correct answer 

to compare students' responses. 

 
Statistics 

 

The Statistics report provides statistical ("psychometric") analysis of the quiz and the questions it 

contains. The report is divided into 3 sections: 
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• a summary of the whole quiz 

• an analysis showing all questions in table format, and 

• a bar graph of the percentage of correct answers (the "Facility index") and the 

"discriminative efficiency index". 

 
The summary section contains the following data items: 

• Quiz name 

• Course name 

• Open/Close dates (only if selected in Quiz settings) 

• Number of complete graded first attempts 

• Total number of complete graded attempts 

• Average grade of first attempts 

• Average grade of all attempts 

• Median grade (for all attempts) 

• Standard deviation (for all attempts) 

• Score distribution skewness (for all attempts) - a measure of the asymmetry relative to 

Gaussian distribution 

• Score distribution kurtosis (for all attempts) - a measure of the shape of probability 

distribution 

• Coefficient of internal consistency (for all attempts) - a measure of whether each quiz 

question is testing the same concept. The higher the number the greater the consistency. 

• Standard error (for all attempts) 

The quiz structure analysis shows the following: 

• Quiz number 

• Question name 

• Attempts 

• Facility index describes - percentage of students who answered the question correctly 

• Standard deviation - the variation of scores for the question 

• Random guess score - the score a student would get for randomly guessing 

• Discrimination index - the correlation between the score for a question relative to the 

student's score for the whole quiz. If a person does well in a question, they should do well 

in the quiz. The higher the number the better the correlation. 

• Discriminative efficiency - the Discrimination index as a fraction of the maximum possible 

marks for the question. For a question with a very high average score (a high Facility index) 

it is very hard for a student to achieve a high Discrimination index on that question. 

 
Manual Grading 

 

The Manual Grading report enables instructors to manually grade written submissions within a 

quiz. 
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It contains the following information: 

• Question number 

• Question name 

• Items to grade 

• Items already graded 

• Total submissions 

 

 
To grade submissions, in the To Grade column select Grade. All the quiz responses to be graded 

will display. Read each submission, provide comments and a final mark and repeat the process until 

all submissions are graded. The comments and marks are exported to the Gradebook when you 

select Save and go to next page after marking each submission. 


